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ANEXO 1.  

Dimensiones generales de la pieza 
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ANEXO 2.  

Guion sobre el manejo de QuikCAST 

 

2.1. Creación y gestión de planos 

Debido a que QuikCAST solo permite dibujar geometrías sencillas, lo más fácil y 

seguro es realizar el diseño de la pieza en cualquier programa de dibujo, siempre y cuando 

sea posible guardar el archivo con la extensión ”.stl”. Para evitar problemas de 

reconocimiento de volúmenes en fases posteriores, es aconsejable incluir en un único 

archivo de dibujo todas las partes del producto final que se obtiene: pieza propiamente 

dicha, sobraderos, bebedero y canal de alimentación. 

 
Otra forma de realizar el diseño es dibujar el producto final por partes, pero para 

ello, hay que ubicar cada parte en el lugar donde se situaría si estuviera la pieza. Esto se 

debe a que el origen de referencia que asume QuikCAST al importar los archivos, es el 

mismo origen que tenemos en el programa de dibujo. Por este motivo en nuestro caso, 

para evitar que el alumno tenga problemas en el momento de realizar la simulación, se 

elige la primera forma de hacer el diseño. 

 
Respecto al bebedero, QuikCAST sólo permite bebederos de forma cilíndrica o 

paralelepípeda. Como lo habitual es que tenga forma cónica, es necesario diseñarlo como 

parte de la pieza. La cuestión es que de esta manera QuikCAST no reconoce el bebedero 

como entrada, y hay que crear con el programa un volumen de entrada y conectarlo con 

dicho bebedero. Por ello, cuando se diseñe (dibuje) el bebedero en el programa de CAD 

resulta necesario recortar su altura original una cantidad (en este caso 5 mm), para que el 

volumen entrada de forma cilíndrica creado con QuikCAST tenga una altura igual a la 

que se ha quitado de la original (5 mm) y un diámetro igual o inferior a la sección superior 

del bebedero dibujado. 

 

Una vez terminado el diseño de la pieza guardamos el archivo con la extensión  

“. stl”. 
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Hay que tener en cuenta que QuikCAST no permite realizar modificaciones en el 

dibujo una vez cargado, por lo que, si es necesario realizar alguna modificación, hay que 

hacerlo en el archivo de diseño. 

 
En el momento de guardar el archivo se deben comprobar las opciones de 

exportación. Para ello iremos a Opciones y comprobaremos que la Unidad de tolerancia 

esté en milímetros. 

 

 
 

2.2. Creación de un nuevo estudio 

A continuación, abrimos el programa QuikCAST y creamos un nuevo estudio. 

Para ello vamos al menú File -> New o iremos al icono en la barra de herramientas, 

apareciendo la siguiente ventana: 

 

 
 

En el apartado Name introducimos el nombre que se quiera dar al estudio. A 

continuación, vamos al apartado Location y hacemos clic en el botón para elegir la 

ubicación donde se guarda el estudio. Hacemos clic en Ok. 
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A continuación, se abre una ventana donde buscamos el archivo de diseño. Luego 

hacemos clic en Open para abrir la pieza en el área de trabajo, apareciendo ahora otra 

ventana donde se eligen las opciones de importación del archivo. 

  
En los apartados Import File y Lengh se elige Metric y Milimeter respectivamente. 

Es importante que las unidades sean las mismas que las que tiene el archivo “. stl”, ya 

que, si no es así, variarán las dimensiones de la pieza. 

 

La opción Welding sirve para unir los puntos, generalmente perteneciente a dos 

regiones diferentes, si se encuentran situados con una diferencia inferior a la de tolerancia 

mostrada. Esta opción se encuentra activa por defecto, y en nuestro caso la dejaremos así. 

A continuación, activamos la opción Automatic Mesh Fixing para que el programa 

compruebe automáticamente si hay algún error en la geometría que se va a abrir. Para 

terminar, hacemos clic en Ok. 

 

Luego aparece una ventana que indica los errores que se han encontrado en la 

geometría de la pieza. Para reparar los errores automáticamente hacemos clic en Yes. 
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Ahora ya se puede observar que la pieza se ha abierto en el área de trabajo. 

 
En este caso hace falta añadir un elemento necesario para el moldeo, el macho. 

Para añadir otra pieza o algún elemento necesario para la realización del moldeo, hay que 

ir al siguiente menú: File -> Import. A continuación, aparecerá una ventana donde 

elegimos el archivo que se quiera abrir. Repetimos el mismo proceso utilizado para abrir 

un nuevo archivo. 

 

Si vamos al menú Edit -> Selection List observamos que el programa ha creado las 

regiones. 
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2.3. Creación de la entrada 

Para crear la entrada hay que ir al menú 2D/3D Mesh -> Mesh Basic Shapes -> 

Inlet o ir directamente al icono. Aparece la siguiente ventana: 

 
En esta ventana tenemos las opciones geométricas y de ubicación de la entrada 

dividido en los siguientes apartados: 

 

• Shape name: permite modificar el nombre que se le asigna a la entrada. En este caso 

dejamos el nombre que aparece por defecto. 

• Shape: permite elegir la forma de la entrada que queremos crear y sus dimensiones en 

mm. Seleccionamos la opción Cylinder e introducimos: 

o Diámetro     20 

o Altura     5 

 

En este caso escogemos este diámetro porque, en realidad, el fluido no entra 

por toda la superficie sino solo por una zona. De esta forma podemos realizar una 

simulación del llenado más cercana a la realidad. La altura del cilindro es porque se ha 

recortado el bebedero 5 mm.Location: permite definir las coordenadas de la ubicación 

de la entrada. Estas coordenadas hacen referencia al punto central de la base de la 

entrada. Como muestra el punto azul de la figura. 
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Para colocar la entrada pinchamos en la zona donde se quiera situar la entrada 

y, a continuación, introducimos las siguientes coordenadas; X=58, Y=50 y Z=65. Estas 

coordenadas se obtienen desde el origen de referencia de la pieza hasta la parte superior 

del bebedero. Hemos elegido esas coordenadas para que el fluido caiga primero en la 

conicidad del bebedero, para evitar que la colada caiga directamente en fondo del canal 

de alimentación. Se puede elegir cualquier punto, siempre y cuando la entrada este 

dentro de la parte superior del bebedero. 

 

• Connected region mesh: esta opción permite conectar la pieza con la entrada. Tenemos 

que activar esta opción puesto que queremos unir la entrada con el bebedero. 

 

• Reverse orientation: permite cambiar la dirección de la orientación de la entrada. 

Activamos esta opción si la orientación de la entrada es la opuesta a la que queremos. 

Esto quiere decir si activa la entrada en vez de hacer la entrada hacia afuera de la pieza, 

se hace hacia dentro de la pieza. 

Para crear la entrada haremos clic en el botón Apply. 

 

La entrada está formada por tres regiones: Bottom (tapa del cilindro), Core (cara 

lateral del cilindro) y Top (base del cilindro). Para comprobar que se han creado iremos 

al menú Edit -> Selection list. Aquí aparecerán las tres regiones que forman la entrada. 

 

 

2.4. Creación del molde 

Para crear el molde vamos al menú 2D/3D Mesh -> Mesh Basic Shapes -> Mold 

o hacemos clic en el icono. El programa considera molde a la caja exterior del molde real, 

de manera que, para definir sus dimensiones, supone que es un paralelepípedo y se 

introducen las coordenadas de los puntos extremos respecto al origen de coordenadas del 

programa. 
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Teniendo en cuenta que las dimensiones del molde son 460 x 800 x 400 mm, para 

introducir las posiciones extremas, hay que tener en cuenta donde está situado el origen 

de coordenadas. El resultado se muestra en la figura. 

 
Introducidas las medidas, hacemos clic en Apply para crear el molde. Si antes de 

cerrar esta ventana se observa algún error en las dimensiones del molde se puede corregir. 

Para ello haremos clic en el botón Undo para deshacer el molde. 

 

Si vamos al menú Edit -> Selection List observamos que ahora se ha creado la 

siguiente región perteneciente al molde: MOLD_SURFACE_ 1. 

 

Como en casos anteriores, una vez cerrada la ventana de creación de molde 

observamos algún fallo en el molde, éste no se puede modificar, por lo que hay que 

eliminarlo. Para ello haremos igual que para borrar la entrada, pero ahora seleccionamos 

la región MOLD_SURFACE_l. 
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2.5. Creación de volúmenes 

Los volúmenes son cada una de cavidades cerradas que forman las regiones. 

 

Para   crear   los volúmenes   iremos   al menú 2D/3D Mesh -> Volume/Region 

Manager, apareciendo la siguiente ventana: 

 

En nuestro caso solo utilizamos la pestaña Volumes, puesto que solo crearemos 

los volúmenes. Esta pestaña está dividida en seis partes: 

 

• Volumes: está situada en la parte superior izquierda, muestra el listado con los 

volúmenes existentes. 

• Available Regions: está situada en la parte superior derecha, muestra el listado de las 

regiones disponibles o superficies que se han ido creando o añadiendo. 

• Automatic volumen detection: está situada en la parte inferior izquierda, muestra 

diferentes opciones para crear de forma automática los volúmenes. 

• Material Interface: está situada en la parte inferior derecha y muestra el interfaz de 

materiales de los volúmenes que se creen. Inicialmente, y mientras no haya volúmenes 

creados, esta opción estará desactivada. 

• Status: está situada en la parte inferior, este apartado nos indica si los volúmenes y 

materiales están bien definidos. 

• Por último, en la parte superior derecha, tenemos el panel que nos permite crear, borrar 

y modificar los volúmenes de manera manual y el definir los materiales. 

Para crear los volúmenes, intentaremos que el programa los reconozca de manera 

automática. Para ello, lo primero es aseguramos que en el apartado Automatic volume 

detection, Connected Regions Mesh está seleccionada la opción No, ya que esta opción 

permite conectar todas las regiones del modelo, creando así un único volumen. 
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A continuación, y dentro del apartado Automatic volume detection, activamos la 

casilla Create Contact Region. Esta opción permitirá crear las regiones de contacto entre 

todas las piezas del modelo.  Luego hacemos clic en el botón para crear los 

volúmenes. Antes de crear los volúmenes, el programa redefinirá las regiones existentes 

y creará unas regiones nuevas en las zonas de contacto entre regiones. A continuación, se 

crean los volúmenes en función de las nuevas regiones. 

 

También aparece una ventana que permite conservar la definición de las antiguas 

regiones. Si no borramos las antiguas regiones, estas siguen apareciendo, pero no tienen 

ninguna relación con los volúmenes. En nuestro caso, hacemos clic en Remove ya que no 

queremos conservarlas. 

 
Ahora, en el apartado Volumes aparecen los volúmenes que se han creado. Se 

pueden observar cuatro volúmenes que pertenecen a la entrada, la pieza, el macho y al 

molde. Para visualizar si están bien los volúmenes, utilizamos los botones situados 

encima de la lista de volúmenes. Si se hace clic en cualquier volumen se observan las 

regiones que conforman el volumen ya que aparecen sombreados en la lista de regiones. 

El volumen 1 es la entrada y el volumen 2 es la pieza. 

 

Es conveniente cambiar el nombre genérico de los volúmenes para distinguirlos 

fácilmente. Para ello hay que seleccionar el volumen y al hacer clic en el botón Rename, 

aparece una ventana donde escribimos el nuevo nombre. 

 

El siguiente paso es asignar el material para cada volumen. Para ello se selecciona 

el volumen Molde y haciendo clic en Material y aparece la siguiente ventana: 
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En el apartado Volume Type se selecciona Mold y en Material List elegimos el 

material. En nuestro caso es STEEL_NF_XC42. Luego hacemos clic en Ok. 

 

Para el macho se repite el mismo procedimiento anterior, pero en Material List se 

selecciona GREEN_SAND como muestra la siguiente imagen. 

 

 
Para seleccionar el material de la pieza, se selecciona el volumen pieza y en el 

apartado Volume Type se selecciona Alloy. En Material List se elige el material, que en 

nuestro caso es AlSi7Mg, y se hace clic en Ok. A continuación, aparece un mensaje 

diciendo que todos los volúmenes restantes también serán del mismo material. 

 

Por último, hay que ordenar los volúmenes por el orden de llenado, dejando al 

final los volúmenes pertenecientes al molde. En este caso se ordena de la siguiente 

manera: entrada, pieza y molde. 
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2.6. Generar la malla 

 
La siguiente etapa es generar la malla de la pieza. Esta malla la utiliza QuikCAST 

para la simulación del llenado y solidificación de la pieza. Por este motivo, conforme la 

malla sea más pequeña, más precisos serán los resultados, pero más tiempo tardará el 

programa en realizar los cálculos. 

 

Para ello vamos al menú 2D/3D Mesh -> 3D Mesh Generation y aparece la 

siguiente ventana: 
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En esta ventana, si queremos que la generación de malla sea de forma automática 

(como es el caso), activaremos la pestaña Auto. Aunque la generación es automática, se 

puede modificar el tamaño de la malla. Para ello, está la opción Uniform, que es la 

seleccionada, para que realice una división uniforme de la malla en los 3 ejes. Si queremos 

que cada eje sea diferente, seleccionaremos Advanced. 

 

En el apartado Select volumen, hay que seleccionar de la lista de todos los 

volúmenes aquellos que pertenezcan solo a la pieza, que en nuestro caso son entrada y 

pieza. 

 

En los siguientes apartados se muestran los valores máximos y mínimos del 

tamaño de la malla. Estos valores se pueden modificar para variar su tamaño, en este caso 

los valores serán los siguientes. 

 
A continuación, hacemos clic en el botón Apply para obtener el número de celdas 

en las que se dividirá la pieza. Una vez realizado aparece en el apartado Grid Information 

el número de celdas y, si se ha realizado de forma correcta, aparece un tic verde. 

 

Luego vamos al apartado Mesh Generation donde generamos la malla. Para ello 

pulsamos el botón Run y, una vez terminado, aparece un tic verde que indica que se ha 

realizado de forma correcta. Para terminar, cerramos la ventana haciendo clic en el botón 

Close. 

 

En esta ventana pueden aparecer diferentes errores: 

 

• Si en el apartado Mesh Generation aparece una cruz roja puede ser porque no se 

hayan creado bien los volúmenes de la pieza al no haber activado la opción Create 

Contact Region. Para solucionarlo iremos al menú 2D/3D Mesh -> Domains 

Manager y comprobaremos que la opción Create Contact Region esté activada, y 

volveremos a crear los volúmenes. 

• Otro error puede ser que el tamaño de la malla no sea el adecuado para la 

geometría de la pieza. Para solucionar esto, modificaremos el tamaño de la malla 

cambiando el valor de la casilla de Average Size. 

• Si aparece un tic rojo en el apartado Grid Information es porque el valor en el 

apartado Max Growth Rate no es el adecuado. Para solucionarlo introducimos en 

esta casilla el valor que muestra el programa al lado de la cruz roja. 
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2.7.     Imposición de las condiciones de contorno 

2.7.1. Gravedad 

El primer punto en las condiciones de contorno es comprobar la dirección que 

lleva la gravedad. En nuestro caso es importante este apartado puesto que realizamos un 

llenado por gravedad. Por este motivo, configuramos la gravedad en la dirección 

adecuada teniendo en cuenta dos aspectos: la dirección que llevan los ejes en la pieza y 

la dirección que llevará el fluido en la entrada de la pieza. 

 

Para ello vamos al menú Cast -> Gravity vector y aparece la siguiente ventana: 

 
Esta ventana está dividida en tres apartados: 

• El apartado Direction muestra la dirección que lleva la gravedad y permite 

modificarla. Por defecto aparece la dirección Z positiva, en nuestro caso no la 

modificamos. 

• En el apartado Constant Gravity se muestra el valor de la gravedad. Este valor se 

puede modificar, por defecto tiene el valor de -9.81m/s2. En nuestro caso dejamos 

el valor por defecto. 

• Por último, en el apartado Option se muestra la opción Tilt Pouring. Esta opción 

permite modificar el grado de inclinación que tiene el molde en el momento del 

llenado. En nuestro caso no activaremos esta opción. 
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2.7.2. Condiciones de contorno 

A continuación, definimos las condiciones de contorno del modelo. Estas 

condiciones permiten imponer límites en el modelo virtual para que se asemeje al modelo 

real. 

 

Existen dos tipos de condiciones de contorno: las hidráulicas y las térmicas. Las 

condiciones hidráulicas hacen referencia a las condiciones del fluido y las térmicas hacen 

referencia a las propiedades que tienen que ver con las temperaturas, intercambio de calor, 

etc. 

 

Para sacar la lista con las condiciones de contorno iremos al menú Cast -> Process 

Conditions Manager. Aparecerá en la parte izquierda del área de trabajo una lista con 

todas las condiciones disponibles. 

 

Para añadir, modificar o eliminar una condición, seleccionamos la condición y le 

damos al botón derecho del ratón. A continuación, elegiremos la opción que se quiera 

realizar. 

 

• Condiciones hidráulicas. 

En nuestro caso vamos a introducir las siguientes condiciones: Initial Fluid, 

Velocity, Permeability y Region Roughness. En todas las condiciones se puede introducir 

el nombre de la condición en el apartado Name. 

 

o Initial fluid: esta condición permite indicar el lugar por donde se inicia el llenado. Para 

introducir esta condición, seleccionarnos la condición y le darnos al botón derecho 

del ratón. Luego elegirnos la opción ADD para añadir una nueva condición y 

aparecerá la siguiente ventana: 

 

En el apartado Fluid fraction se introduce el 100% ya que se considera que, por 

el volumen entrada, pasa toda la colada en forma líquida. Luego seleccionamos la 

opción Imposed. Esta opción permite que la entrada se mantenga llena en todo 

momento. A continuación, iremos al área de trabajo y seleccionaremos la entrada con 

el botón izquierdo del ratón. Seleccionaremos este volumen porque por ahí entra la 
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colada. Comprobamos que en el apartado Volume list esté seleccionada la Entrada y 

le damos a OK. 

 

o Velocity: esta condición permite imponer la velocidad de llenado. 

 

Para introducir esta condición, seleccionaremos la condición y le daremos al botón 

derecho del ratón. Luego elegiremos la opción ADD para añadir una nueva condición. 

 

En el apartado Velocity se introduce la velocidad de llenado del molde en m/s. Esta 

velocidad se puede definir de dos formas: si elegimos el primer botón: tendrá un valor 

fijo; si elegimos el segundo botón podemos introducir una ecuación, de esta manera 

tendrá un valor variable. En nuestro caso introducimos el valor fijo de 0.2 m/s. 

 

A continuación, vamos al área de trabajo y seleccionamos, con el botón izquierdo del 

ratón, la parte superior de la entrada. Seleccionamos esta región porque entrará por 

ahí la colada. Comprobamos que en el apartado Region list esté seleccionada la opción 

EXTF-Entrada y le damos a OK. 

 

o Region Roughness: esta condición permite simular la rugosidad que hay en el interior 

del molde. 

 

Para introducir esta condición, seleccionamos la condición y le damos al botón 

derecho del ratón. Luego elegimos la opción ADD para añadir una nueva condición. 

 

En el apartado Roughness Index se muestra el valor de la rugosidad del molde. Este 

valor aparece por defecto dependiendo del material del molde que elijamos. 

 

A continuación, vamos al área de trabajo y seleccionamos la parte exterior de la pieza 

porque es en esta región donde la rugosidad del molde afecta al proceso de llenado, 

es decir, en el apartado Region List estará seleccionada la opción EXTF-Pieza y le 

damos a OK. 

 

• Condiciones térmicas. 

En nuestro caso vamos a introducir las siguientes condiciones: Temperature, 

External Exchange y Contact Resistance.  En todas las condiciones se puede introducir 

el nombre de la condición en el apartado Name. 

 

o Temperature:  esta condición permite indicar la temperatura que va a tener el material 

fundido en el volumen entrada. 

 

Para introducir esta condición, seleccionamos la condición y le damos al botón 

derecho del ratón. Luego elegimos la opción ADD para añadir una nueva condición. 

 

En el apartado Condition elegimos la opción Imposed. De esta forma se mantendrá 

esa temperatura durante toda la etapa que elijamos. 

 

El apartado Temperature definition muestra el valor de la temperatura. Esta 

temperatura se puede definir de dos formas: si elegimos el primer botón tendrá un 
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valor fijo, si elegimos el segundo botón podemos introducir una ecuación, de esta 

manera tendrá un valor variable. Esta temperatura, por defecto, tiene un valor que 

viene definido por el material de la aleación. En nuestro caso dejamos el valor por 

defecto. 

 

En el apartado Applies to activamos solo la opción Filling ya que, queremos aplicar 

esa temperatura solo durante el proceso de llenado. 

 

A continuación, y dado que el área de trabajo es la entrada, comprobamos que en el 

apartado Object, está seleccionada la opción Entrada, y le damos a OK. 

 

o External Exchange: esta condición permite indicar la transferencia de calor que se 

produce entre el molde y el exterior. 

 

Para introducir esta condición, seleccionamos la condición y le damos al botón 

derecho del ratón. Luego elegimos la opción ADD para añadir una nueva condición. 

 

En el apartado External Temperature se muestra el valor en ºC de la temperatura 

exterior. En nuestro caso elegimos el valor de 20ºC. 

 

En Material Emissivity se muestra el valor del coeficiente de emisividad que tiene el 

material del molde con el exterior. Este coeficiente es un número adimensional. El 

valor de la emisividad, por defecto, viene dado por el material del molde. En nuestro 
caso dejamos el valor por defecto. En el apartado Applies to activamos la opción 

Filling y Solidification ya que, el intercambio de calor afecta a las dos etapas. 

 

En el apartado Type of Exchange se puede elegir el tipo de intercambio que se tiene 

en cuenta. En nuestro caso elegimos la opción Radiation and Convection puesto que 

se producen ambos tipos en nuestra pieza. 

 

Por último, seleccionamos la región exterior del molde, es decir, en Region List tiene 

que estar seleccionada EXFT-Molde.  Le damos a OK. 

 

o Contact Resistance:  esta condición se utiliza para imponer la resistencia térmica que 

se produce por estar en contacto una región. 

 

Para introducir esta condición, seleccionamos la condición y le damos al botón 

derecho del ratón. Luego elegimos la opción ADD para añadir una nueva condición. 

 

En el apartado Resistance or HTC permite elegir el tipo de contacto que se produce. 

Dependiendo de la opción elegida las unidades varían. Estas unidades aparecen en 

cada apartado. 

 

En nuestro caso, elegimos la opción Resistance ya que el intercambio de calor se 

produce por una resistencia térmica. El valor que se muestra viene dado por defecto 

dependiendo del material de la pieza. Este valor se puede definir de dos formas: si 

elegimos el primer botón tendrá un valor fijo; si elegimos el segundo botón podemos 

introducir una ecuación, de esta manera tendrá un valor variable. En nuestro caso 

dejamos el valor por defecto. 
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En el apartado Applies to activamos solo la opción Filling ya que, queremos aplicar 

esa condición solo durante el proceso de llenado. 

 

A continuación, vamos al área de trabajo y seleccionamos la pieza. Comprobamos 

que en el apartado Regions esté seleccionada la opción EXFT-Pieza y le damos a OK. 

 

2.8.      Cálculo de resultados 

A continuación, iniciamos los cálculos de los resultados. Para ello iremos al menú 

Standard Simulation -> Start Simulation y aparece una ventana. 

 

En esta ventana elegimos la pestaña Filling and Solidification puesto que 

queremos obtener los cálculos para el llenado y la solidificación. Esta ventana muestra 

los siguientes apartados: 

 

• Calculation type: permite elegir el método de cálculo y las temperaturas iniciales. En 

nuestro caso elegimos la opción Standard calculation. Introducimos el valor 20ºC 

tanto para el molde como para la cavidad del molde. 

• Stop Filling Criteria: sirve para definir los parámetros de parada para los cálculos de 

llenado. Los cálculos se paran cuando hayamos sobrepasado el tiempo de llenado o 

cuando sobrepasemos el porcentaje de llenado que previamente hemos introducido en 

este panel. En nuestro caso dejamos los valores por defecto. 

• Stop Solidification Criteria: sirve para definir los parámetros de parada para los 

cálculos de solidificación. Los cálculos se paran cuando sobrepasemos el tiempo se 

solidificación o la temperatura sea inferior a la que previamente hemos introducido 

en este panel. En nuestro caso dejamos por defecto el valor del tiempo máximo. Solo 

se cambia la temperatura máxima a 200 ºC. 

• Options: en este aparatado seleccionamos la opción None ya que se trabaja en una 

fundición por gravedad. 

En el resto de los apartados dejamos las opciones que vienen por defecto. 

 

Una vez que ya hemos introducido todos los parámetros le damos al botón Run. 

A continuación, QuikCAST empezará a realizar los cálculos. Aparecerá la siguiente 

ventana que indicará los progresos que llevan los cálculos para cada proceso. 

 

Una vez que los cálculos han terminado aparece un mensaje indicando que han 

finalizado. El programa creará un archivo de resultados donde solo aparecen los 

resultados. Este archivo mantiene el mismo nombre del estudio, pero tiene la extensión 

“. mco”. 

 

2.9.      Resultados 

Una vez que se han completado los cálculos tanto de llenado como de 

solidificación el último paso es ver los resultados. 
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Para ello, abrimos el archivo de resultados creado por el programa. Vamos al menú 

File -> Open y seleccionamos el archivo con extensión “. mco". El programa crea el 

archivo con el mismo nombre que el estudio. Aparece una ventana donde elegimos los 

volúmenes que queremos abrir. Para ello seleccionamos la pieza y la entrada y dejamos 

marcada la opción Use Smoothing Mesh. Si no marcamos esta opción la pieza se abrirá 

con la forma de la malla. 

 

Una vez que hemos abierto el archivo iremos al menú Results. Ahora en este menú 

ya están disponibles todas las formas de ver los resultados. 

 

Si vamos al menú Results -> Mesh Correction Factors, aparecerá una ventana en 

la que eligiendo la opción volumen, muestra el porcentaje de aleación que tiene cada celda 

de la malla de volumen que habíamos creado. 

 

Si vamos al menú el Results -> Filling / Solidification aparece una ventana que 

permite ver las distintas etapas de los procesos de llenado y de solidificación de la pieza. 

En la opción Type seleccionamos el proceso que queremos ver, en Results Type elegimos 

la variable a analizar y si se encuentra activada la opción de Show Liquid, se pueden ver 

las zonas con líquido. Se pueden activar o desactivar en función de los procesos que se 

quieran ver. 

 

Si elegimos el proceso de llenado (Filling) tenemos las siguientes opciones: 

 

• Fill Rate: muestra el llenado de la pieza. 

• Temperature: muestra la temperatura durante el llenado. 

• Pressure: muestra la presión en la pieza durante el llenado. 

• Velocity: muestra la velocidad del flujo durante el llenado. 

• Fill time: muestra que partes se han llenado durante un determinado tiempo. 

Si elegimos el proceso de solidificación (Solidification) tenemos las siguientes 

opciones: 

 

• Liquid Fraction: muestra la parte líquida que hay en la pieza. 

• Temperature: muestra la temperatura durante la solidificación. 

• Shrinkage: muestra la contracción que se producen en la pieza. 

• Solid Fraction: nos muestra la parte sólida que hay en la pieza.  

Para ver los resultados, podemos ir fijando en cada una de las etapas seleccionado 

la etapa que queremos ver en la lista de la derecha. También podemos seleccionarla todas 

y con la opción Multiple state y dándole al botón Generate movies podemos verlo en 

forma de vídeo. Si queremos guardar el vídeo activaremos la opción Create an-AVI File. 

Hacemos clic en Generate. 

 

Si vamos al siguiente menú Results -> Process Sypnosis aparecerá la siguiente 

ventana: 

 

En esta pantalla se puede elegir los resultados que queremos analizar: 

• Defects: muestra los resultados relacionados con los cálculos de predicción de 

defecto. 
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o Shrinkage: proporciona información sobre la contracción en la aleación. Se 

observa las contracciones que sufre la pieza cuando ya se ha solidificado. 

o Dendritic Arm Spacing: informa sobre la micro estructura de la aleación.  

o Niyama Criterion: calcula según el criterio de Niyama. Informa sobre la porosidad 

por contracción de la aleación. 

o Solidifiction Rate: calcula la velocidad de enfriamiento. 

o Volume Fraction of Gas Porosity: proporciona información acerca de la micro 

porosidad del gas. 

 

• Solidification:  muestra los resultados con el final de los cálculos de la solidificación. 

 

o Time to Solidus: proporciona el tiempo que necesita la aleación para alcanzar la 

temperatura de sólido 

o End of Calculation temperature:  proporciona información sobre la temperatura 

al final de los cálculos. 

o Time to Critical Solid Fraction: proporciona el tiempo que necesita la aleación 

para alcanzar el valor crítico de la fracción sólida. 

o Time to Eutectic Temperature: tiempo que tarda la aleación en alcanzar la 

temperatura eutéctica. 

o Temperature Gradient at Eutectic Temperature:  informa sobre los gradientes 

térmicos en la aleación a la temperatura eutéctica. 

o Temperature Gradient at Solidus - Degrees Celsius: informa sobre los gradientes 

térmicos en la aleación en la fase sólida. 

o Local Cooling Rate: informa sobre la velocidad de enfriamiento. 

o Solidification Time: muestra el tiempo de solidificación. En esta opción se muestra 

de forma gráfica cuanto tiempo tarda en solidificase cada zona de la pieza. 

 

En la opción Style podemos cambiar la forma de visualizar los resultados de la 

pieza. 
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ANEXO 3.  

Resultados de las simulaciones con 

QuikCAST 

 

3.1.     Primer modelo 
 

• Filling Fill Rate 
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• Filling Pressure 
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• Filling Temperature 
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• Filling Velocity 
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• Solidification Liquid Fraction 
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• Solidification Shrinkage 
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• Solidification Solid Fraction 
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• Solidification Temperature 
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3.2.     Segundo modelo 
 

• Filling Fill Rate 
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• Filling Pressure 
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• Filling Temperature 
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• Filling Velocity 
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• Solidification Liquid Fraction 
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• Solidification Shrinkage 
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• Solidification Solid Fraction 
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• Solidification Temperature 
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3.3.     Tercer modelo 
 

• Filling Fill Rate 
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• Filling Pressure 
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• Filling Temperature 
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• Filling Velocity 
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• Solidification Liquid Fraction 
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• Solidification Shrinkage 

 

 
 

• Solidification Solid Fraction 

 

 
 

 
 

• Solidification Temperature 
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• Process Synopsis (Defects) 

 

o Shrinkage 

 

 
 

o Dendritic Arm Spacing (DAS) 

 

 
 

o Niyama Criterion 

 

 
 

o Solidification Rate 
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• Process Synopsis (Solidification) 

 

o Time to Solidus 

 

 
 

o End of Calculation Temperature 

 

 
 

o Time to Critical Solid Fraction 

 

 
 

o Time to Solidus-X 
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o Temperature Gradient at Solidus- X Degrees Celsius 

 

 
 

o Local Cooling Rate 

 

 
 

o Time to End of Mass Feeding 

 

 
 

o Solidification Time 

 

 
 

 

 

 

 

 


